
   

 

 
 
 
NZC GUIDE TO  
PRO CRICKET SCORER 
2021/22 EDITION  



2 

 

Contents 

Contacts ............................................................................................................................................................. 2 

Setting Up .......................................................................................................................................................... 3 

Pre-Match .......................................................................................................................................................... 4 

Scoreboard ........................................................................................................................................................ 5 

Activations and Video Replays ...................................................................................................................... 6 

Layout ................................................................................................................................................................ 7 

Match Details ..................................................................................................................................................... 8 

Scoring Processes ............................................................................................................................................ 10 

Innings Timer ............................................................................................................................................... 10 

Scoring Options ........................................................................................................................................... 10 

Additional Data ............................................................................................................................................ 10 

Standard Scoring Mode ............................................................................................................................... 11 

One-Click Scoring Mode .............................................................................................................................. 11 

Interface Scoring .......................................................................................................................................... 11 

Keyboard Scoring ......................................................................................................................................... 12 

Edit Mode ........................................................................................................................................................ 13 

Edit Match Details and Teams ..................................................................................................................... 13 

Innings and Milestone Notes ........................................................................................................................... 14 

Power Plays ..................................................................................................................................................... 14 

Delayed Play .................................................................................................................................................... 15 

DLS and Revised Overs / Target ....................................................................................................................... 16 

Short Form Match........................................................................................................................................ 16 

Short Form Match - DLS Par Score Sheets ................................................................................................... 17 

Long Form Match......................................................................................................................................... 17 

End of Innings / Match .................................................................................................................................... 17 

Scorecards and Scoresheets ............................................................................................................................ 18 

 

Contacts 

REGAN RAMSAY-BOYD 
Cricket Technology Manager 
   regan.ramsayboyd@nzc.nz | 027 863 3262 

CHARLIE BREWER 
Head Of Cricket Operations 
   richard.brewer@nzc.nz | 027 365 1835 

JUSTINE MESSERER 
Match Official Coordinator 
   justine.messerer@nzc.nz | 021 226 3006 
  

mailto:regan.ramsayboyd@nzc.nz
mailto:richard.brewer@nzc.nz
mailto:justine.messerer@nzc.nz


3 

 

Setting Up 
1. Double-Click the Pro Cricket Scorer icon on the desktop and enter your login details into the prompt.  

If you do not know your password, use the ‘Forgot Password’ function. If you do not know your username, 
contact NZC.  

 

 

 

 

 

2. PCS may prompt you about Server Changes – if so, Select Yes. PCS will then open the PCS main screen and 
automatically open the last opened match. The last used Layout and Ground Configuration will be loaded also.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. A Layout is made up of panels you can move individually by clicking and dragging. You can resize these panels 
clicking and dragging the space between the panels. Select from a list of default layouts in the ‘View’ menu at the 
top of the screen and select ‘Scoring – Default’. See the Layout section (Page 7) for more info. 

 
4. A Ground Configuration is the custom settings file configured to output to a certain venue scoreboard. To change 

the ground configuration file, click the ‘Settings Cog’ above the Scoreboard Display window on PCS. See the 
Scoreboard section (Page 5) for more info. 

 

You can also check the ‘Configuration’ settings for other scoring settings options. Go to the ‘Tools’ menu, select 
Configuration, go to the ‘Scoring’ tab, and select or unselect the various options as required, and click ‘OK’. It is 
recommended that these settings at left as default. 
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Pre-Match 

1. To close the current match, go the ‘File’ menu and select ‘Close Match’. 
 

2. To start a new match, go to the ‘File’ menu and select ‘Start Match from Fixture…’ 
 

3. To open a previously started match, go the ‘File’ menu and select ‘Open Match…’. 

 

 

 

 

 

 

 

 

 

 

 

4. From the ‘Start Match from Fixture’ prompt, click once on your match then click ‘Continue’. This will open the 
‘Start from Fixture’ details window.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Consider the bottom section of this window and ensure all details are correct including Match Details and Match 
Officials. If this information is incorrect, contact NZC.  

5. In the lower left-hand corner, tick the box to the left of ‘Start with No Players’. Then click ‘Start Scoring’ and ‘Start 
as Live Scorer’. Your match will now be in the ‘Pre Toss’ play state.  

At this point take the time to ensure the Scoreboard and Layout are setup correctly. 
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Scoreboard 
Any NZC Scoring Laptop can control a venue scoreboard; however, specific laptops are set up to automatically run 
scoreboards they are connected to. It is recommended each venue use the same scoreboard laptop throughout the 
season to minimize set-up time.  

Changes made to the following settings can be saved as a Ground Configuration file by clicking on the settings cog 
menu in the top right corner of the Scoreboard panel and selecting ‘Save As…’. 

1. When arriving at a venue ensure your scoreboard laptop is connected to the scoreboard via the HDMI cable 
before powering on the laptop. If the laptop has been used at this venue previously to your arrival, when 
opened PCS should output to the scoreboard automatically.  

2. If it does not, click on the settings cog menu in the top right corner of the Scoreboard panel, select ‘Open 
Ground Configuration…’, and double-click on the correct ground configuration file for your venue.  

Note: All NZC Scoring Laptops should come pre-loaded with ground configuration files for most venue scoreboards in 
your area. If your laptop does not have the correct .gcf file, contact NZC.  

 

 

 

 

 

 

 

3. If the output in the Scoreboard panel is not displaying on the 
venue scoreboard, return to the Scoreboard panel settings cog 
menu, click ‘Screen Settings…’, and check the ‘Monitor’ dropdown, 
which should be set to the second monitor on the list (often the 
first and second options are both called ‘Generic PnP Monitor’).  

 
Click the ‘Update Screen’ button to apply any changes you have 
made in the Screen Settings menu.  

 

If there is only one option in the ‘Monitor’ setting dropdown 
list, the venue scoreboard is not connected correctly.  

 
4. Close Pro Cricket Scorer and return to your laptop’s 

desktop.  
 

5. Right click anywhere on the desktop and select 
‘Display Settings’.  

 
 

6. If a second display (venue scoreboard) is 
NOT connected your Display Settings 
window will look like this. Check your 
HDMI cable is connected correctly. If the 
settings window does not change, restart 
your laptop. 
 

7. If upon restarting your laptop the Display 
Settings window still has not changed, 
speak to the Venue Manager to ensure 
the Scoreboard is powered on. 
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8. If a second display (venue scoreboard) is 
connected your display window may look 
like this. This is still incorrect.  
 
 
 
 
 
 
 
 
 
 

9. Scroll down to the ‘Multiple Display’ 
setting. From the dropdown list select 
‘Extend these Displays’. 
 

10. From the ‘Scale and Input’ section, ensure 
the ‘size of text, apps and other items’ 
setting is set to 100%. 
 
 
 
 
 
 

11. If setup correctly, your Display settings 
will look like this.  
 

12. Reopen Pro Cricket Scorer. 
 

13. PCS should output to the scoreboard 
automatically. If the scoreboard output is 
covering your laptop screen, return to the 
Scoreboard panel settings cog menu, click 
‘Screen Settings…’, and check the 
‘Monitor’ setting. Again, this should be 
set to the second option on the 
dropdown list. 
 

Activations and Video Replays 

‘Screen Activation Settings’ are also saved to the Ground 
Configuration file. Screen Activations are the images that 
display across the scoreboard in the event of a 4, 6, or 
Wicket. There are different image sets for each NZC 
Competition. 

Ensure the correct images are loaded from the media library 
by returning to the Scoreboard panel settings cog menu, click 
‘Screen Activation Settings…’ to open the Activations window.  

Tick ‘Enable’ next to each Activation and select the 
appropriate image from the ‘Media Library Image’ dropdown.  

If you are Live Scoring with a Performance Scorer (Analyst), 
tick the ‘Show Video Replay if available’ option below Wicket 
Activation only. This will play video replays of each wicket on 
the scoreboard.  

It is not recommended that you tick ‘Show Video Replay if 
available’ for 4s or 6s as there is often not enough time mid-
over for the replays to display in full.  
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For video replays to work, go to the ‘Video’ menu and tick ‘Live Download (Highlights Only)’. PCS will download video 
clips of wickets, 4s and 6s. You can also right click any ball in the ‘Ball by Ball’ panel and select ‘Download Web Video’.  

Then it is possible to manually trigger Video Replays at appropriate times, such as 
at the end of an over. In the Slide Control panel, the ‘Video’ section includes 4 
buttons that become available when the relevant ball clip is downloaded. In the 
‘Ball by Ball’ panel select the 4, 6, or Wicket you would like to replay, and click 
‘Selected Ball’ in the ‘Slide Control’ panel to trigger the replay.  

 

 

 

 
 
 

 

 
 

Layout  
Select from a list of default layouts in the ‘View’ menu. Within this menu, you can also add or remove specific panels 
by selecting from the list starting with ‘Scoring Entry’. If your current layout is not operational, select ‘Reset to Last 
Saved Layout’ or ‘Reset to Default Layout’.  

A Layout is made up of individual panels which are movable and resizable. You can resize a panel by clicking the edge 
of one with the left mouse button and dragging. You can move a panel by clicking the grey bar at the top of each panel 
with the left mouse button and dragging.  
 

 

 

 

 

 

 

 

 

 

 

 

When moving a panel, the grey bar will turn blue. Keep holding the left mouse button and hover over another panel. A 
plus shaped window will appear over the panel with 5 options for repositioning. These represent placing your held 
panel left, right, above, below or stacked on top of the panel you are hovering over. You will see a preview of where 
your held panel will be situated, indicated by the blue area. Release the left mouse button whilst hovering over your 
desired option.  

Choosing the middle option will stack the held panel into a group with the panel you are hovering over, you can then 
switch between them quickly by selecting the names in the grey bar at the bottom of the panel group. Clicking and 
dragging the top grey bar of a panel group will move all panels in that group together. Click the panel name in the 
bottom grey bar will move that panel individually.  

If you have made changes to the default layout and would like to save them, go the ‘View’ menu, select ‘Save Layout 
As’ and give it a custom name.  

If any of the panels do not appear correct or you are unable to fix them, go to the ‘View’ menu, and select ‘Reset to 
Last Saved Layout’ or ‘Reset to Default Layout’.  
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Match Details 
1. In the ‘Pre-Toss’ play state you can add players to the match without them appearing live on the Match Centre. 

The players and squads will appear live on the Match Centre once you have entered the Toss Details. 
 

2. From the Slide Control panel, you can display the Clock or Countdown slides on the Scoreboard. 
 

3. To add players to the match, go to the ‘Scoring’ menu and select ‘Match Details / Teams…’. Or click the 
highlighted ‘Add Players’ button on the PCS main screen. This will open the ‘Edit Match’ window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. By default, PCS will load each team’s last used squad. Edit the squad lists by highlighting any player and clicking 
‘Remove’. Use ‘Add Player’ to add players who did not play in their team’s previous match.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5. Use the ‘Club’ or ‘Team’ dropdown lists, the gender check boxes or the ‘Name’ field to find a required player, then 
click ‘Add’, and then ‘Close’.  

 
6. If you are unable to find the required player, use the ‘Show All Players’ button before typing their name into the 

‘Name’ field.  
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7. If a player is not in the PCS database, click the ‘Create 
New Player’ tab at the top of the Add Player window. 
You must gather and enter all critical information when 
creating a new player.  

 
Critical Information includes… 

A. First Name 
B. Middle Name (or initials) 
C. Last Name 
D. Shirt Number 
E. Gender 
F. Left-Handed Batsmen? 
G. Bowling Type 
H. Keeper? 
I. Date of Birth 

 
 
 

8. In the Match Details/Teams window, ensure any players with the 
same last name are identified with an initial. To do this, double 
click their ‘Short Name’ cell and edit the text. 

 
9. In the Match Details/Teams window, ensure all players have the 

correct shirt number allocated. To do this, double click their 
‘Shirt #’ cell and input the number. 

 
Red text in the ‘Short Name’ or ‘Shirt #’ columns indicate that 
the data is different to what is saved on the server. To save a 
player’s short name or shirt number to the server, highlight their 
name in squad list and click ‘Edit’. Enter the data in the ‘Shirt 
Number’ and/or ‘Short Display Name’ fields and click ‘Save’. 

 
10. Assign the Captain, Wicketkeeper, and Twelfth Man using the 

dropdown boxes. Always assign a Twelfth Man when possible. If 
your match allows the twelfth player to bat or bowl, include the 
twelfth player on the squad list, but leave the ‘Twelfth Man’ 
dropdown box empty.  

 
11. Once the Toss has occurred on-field, you will receive the official team sheet 

from the Umpires, Match Referee or Venue Operations Manager. At this point, 
confirm the squads you have entered are correct. Click ‘Save’. 

 
12. To enter the Toss result, go the ‘Scoring’ menu and select ‘Toss Details…’. Or 

click the highlighted ‘Record Toss’ button on the PCS main screen. This will 
open the Toss Details window. Select an option for ‘Toss won by’ and ‘Toss 
decision’ then click ‘Save’. 

 
13. As the players and officials are in position on-field, click the highlighted ‘Start 

Play’ button on the PCS main screen. Confirm the Striker and Non-Striker.  
Confirm the Opening End and the Umpire at that end. This starts the Innings Timer. 
 
If you have entered any of this information incorrectly, click the ‘Undo’ button, or 
select ‘Pre-Toss’ from the ‘Play State’ dropdown to start again. 
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Scoring Processes 

Innings Timer 

The innings timer starts when ‘OK’ is clicked on the ‘Opening End’ window after clicking ‘Start Play’. All innings breaks 
are accessed from the ‘Play State’ dropdown list on the PCS main screen. 

The innings timer will stop for any break where the players leave or remain off the field (Rain, Ground Delay, Bad 
Light, Lunch, Tea/Dinner, End of Day, and End of Innings). 

The innings timer will remain on for any break where the players do not leave the field (Drinks, Ball Change, Injury, 
Crowd Interruption, or Break in Play). 

Go to the ‘Scoring’ menu and select ‘Innings Times’ to open the ‘Edit Innings Times’ window. 

- To edit a batsman’s minutes, for to the ‘Batting Times’ tab, double-click on the player’s ‘Time In’, ‘Time Out’, 
‘Minutes’ and/or ‘Seconds’ boxes, type in the correct number, press Enter and click ‘OK’. 

- To change the total minutes for an innings, click on the ‘Partnership Times’ tab, double-click on any 
partnerships ‘Minutes’ box that are incorrect, type in the correct number, press Enter and click ‘OK’. 

- The partnership minutes are added up to calculate the tot innings minutes displayed on the Scorecard within 
the main panel and on the live scorecard. 

- If you forget to add a break when it occurs, go to the ‘Scoring’ menu and select ‘Innings Times’, select the 
‘Breaks’ tab, ‘Add’ the missing break, then double-click on its ‘Innings’ and/or ‘Over/Ball’ box and select the 
correct time for the Break. 

- Use the ‘Edit Innings Times’ window to amend the 'Start Time' and 'End Time'. This will not recalculate any 
affected batsmen's or partnership times. 

Scoring Options 

1. The Score Summary panel can be set to ‘Full’ or ‘Compact’, 
by selecting the settings cog menu in the top right corner of 
the Score Summary panel.  

2. The Play Control panel has settings, accessed through the 
settings cog menu in the top right corner of the Play Control 
panel, including ‘Auto Start Ball’ and ‘Auto End Ball’ which 
are set ON by default. ‘Auto End Over’ will disable the end of 
over confirmation window, this is set OFF by default.  

3. The Scoring panel can be set to ‘Standard’ or ‘One Click 
Scoring’ in the settings cog menu in the top right corner of 
the Scoring panel. See the scoring modes section (Page 11) 
for more info. 

These settings can be saved with the layout by going the ‘View’ menu 
and selecting ‘Save Layout As’.  

Additional Data 

In the ‘Play Control’ panel, there are some icon buttons to assist the scoring process, including: 

- Swap Batsmen: For swapping the Striker/Non-Striker.  
(Next to ‘Striker’) 

- Edit Batting Order: For changing the batting order.  
(Next to ‘Non-Striker’) 
 

- Keeper Up: Toggle for when the wicketkeeper is standing up  
to the stumps (Next to ‘Bowler’). 

- Around the Wicket: Toggle for when the bowler is bowling 
around the wicket (Next to ‘Bowler’). 

- Undo: For deleting the last ball, over, action. Also used to 
undo the start or end of an innings (Next to ‘Edit’) 

- Key Moment: For marking balls as key moments for analysis 
purposes (Not required by Scorers). 

- End Over/Umpire Signal: For manually ending an over or 
recording other umpire signals (Next to ‘End Ball’). 
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In the ‘Score Summary’ panel, there are some more features that require scorer input.  

- DRS: Enter the number of Incorrect Reviews permitted per team. 
- Over Rate: Enter the target over-rate (Not required at NZC matches). 
- Cut-Off: End of Day time (Not required at NZC matches).  
- Overs Rem: Shortcut to adjust the Overs Remaining in the day. 
- WASP: (Short Form Only) Enter the Par Score for this match. 

Standard Scoring Mode 

By default, PCS is in ‘Standard’ scoring mode with ‘Auto-End Ball’ and ‘Auto-Start Ball’ on. In this setup the runs must 
be entered last as this ends the current ball and starts the next ball. So, if extras or a dismissal with runs occur the 
extra or wicket must be entered first.  

One-Click Scoring Mode 

In ‘One-Click Scoring’ mode, there is a button for every combination of runs and extras, so just click the required 
button for each ball. Again, with ‘Auto-End Ball’ on, you must enter the runs or extras last as this ends the current ball 
and starts the next ball.  

In either scoring mode, when a dismissal with runs occurs, the ‘Wicket’ must 
be entered first.  

1. Click ‘Wicket’. This will open the ‘Wicket/Referral’ window.  

2. Un-tick the ‘End Ball (0 runs/extras)’ checkbox before clicking ‘OK’, 
then enter the runs or extras that occurred to end the ball.  

3. Return to this window by using the ‘Edit’ function (See Page 13) and 
clicking ‘Wicket’ to add information extra info you may have missed.  

Interface Scoring 

Batsman’s Runs are scored by:  

- ‘Runs 0, 1, 2, 3’ as required, and ‘No Ball (Runs)’ buttons for any 
additional runs off the bat.  

- ‘Runs 4’ or dropdown arrow then ‘4 Runs (Boundary)’ for a Boundary 4. 
- ‘Runs 6’ or dropdown arrow then ‘6 Runs (Boundary)’ for a Boundary 6. 
- Dropdown arrows then ‘4 or 6 Runs (All Run)’ for an All Run 4 or 6.  
- ‘Runs 6’ dropdown arrow for 5, 7, 8, 9, 10, 12, and 20 Runs.  

Extras Runs are scored by:  

- ‘Wides w’ for 1 Wide, ‘Wides +1’ for 2 Wides, ‘Wides +2’ for 3 Wides, ‘Wides +3’ for 4 Wides,  
‘Wides +4’ for 5 Wides, and ‘Wides ?’ for 5, 6, 7, 8, and 9 Wides.  

- ‘No Ball (Runs) 0' for 1 No Ball with no additional runs. 
- ‘No Ball (b)’ or ‘No Ball (lb)’ buttons for the number (1 to 9) of byes or leg byes off a no ball. 
- ‘Byes’ and ‘Leg Byes’ buttons for the number (1 to 9) of byes or leg byes off a delivery. 

Penalty Runs are scored by:  

1. Select ‘Pen’ to open the ‘Penalties’ window. Select the appropriate Law that has been breached from the 
dropdown list and click 'Add' to award the standard 5 Penalty Runs. 

A default Par Score will be set 
for each short-form match, this 

can be adjusted by the live 
scorer. 
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2. Alternatively, if the number of runs is 
something other than 5, or you are not sure 
which Law has been breached, use the ‘Other 
Penalty (Batting or Bowling)’ or ‘Over Rate’ 
options from the dropdown list, enter the 
number of runs to be awarded, and click ‘Add’ 
to award the Penalty. 

3. For most Penalties the ‘Add to Previous Ball’ 
checkbox will be ticked, but for those laws 
where runs off the bat can also be scored, and 
the ball of the over does not count, this will 
be automatically un-ticked and the ‘Set as Illegal Ball’ ticked instead. Again, click ‘Add’ to award the Penalty. 

4. Penalties incorrectly awarded can be removed by highlighting them in the list, right-clicking and selecting 
‘Delete Penalty’. 

Wickets and Retirements are scored by: 

1. As previously mentioned, select ‘Wicket’ to open the ‘Wicket/Referral’ Window. 

2. Enter the Player Dismissed, Dismissal Type, Fielder(s), Sub Fielder(s), and Fielding Position.  

3. If the batsmen cross while a catch is being taken or during a run out, tick the ‘Batsmen Crossed’ checkbox to 
automatically switch the incoming batsman as Striker or Non-Striker, as appropriate. 

4. Select the incoming batsman from the ‘Confirm Batsman’ prompt, use the dropdown list if they are not the 
next player on the team list, click ‘OK’. The batting order on the scorecard will update automatically.  

5. If the next batsman does not take the field because the fall of the wicket prompts a break, e.g., Rain, Lunch, 
Tea or End of Day, click ‘None/Unknown’ then enter the break. When play resumes, click ‘Set Batsman’ to re-
open the ‘Confirm Batsman’ prompt and select the new batsman. 

6. If a batsman retires, click the dropdown arrow on the ‘Wicket’ button 
and select ‘Retirement’ to open the ‘Retired Batsman’ window, then 
select the batsman retiring and the type of retirement, click ‘OK’. 

‘Retired Hurt’ is no longer used in scoring, use ‘Retired-Not Out' in its place. 
‘Retired Out’ should only be used if you are sure that they will not resume their 
innings later, click ‘OK’. 

In most cases, the retirement will be entered after the ball on which it occurred 
has been scored, so the ‘Add to Previous Ball’ checkbox will be ticked, but if not 
untick this box before clicking ‘OK’. 

 

Keyboard Scoring 

The keyboard scoring functionality is always available. Below is a list of keyboard shortcuts available on PCS.  

- Space Bar to Start Ball and End Ball if NOT in Auto-Start Ball and/or Auto-End Ball mode. 
- 0 or Space Bar for a dot ball.   
- 1, 2, 3, 4, 5, 6, 7, 8, 9 for the respective number of Runs off the bat. 
- w for a wide, w and 1 for 2 Wides, w and 2 for 3 Wides, w and 3 for 4 Wides, w and 4 for 5 Wides, etc. 
- n for a No Ball, n and 1 for a No Ball and 1 Run, n and 2 for a No Ball and 2 Runs, etc. 
- n, l and 1 for a No Ball with 1 Leg Bye, n, l and 2 for a No Ball with 2 Leg Byes, etc. 
- n, b and 1 for a No Ball with 1 Bye, n, b and 2 for a No Ball with 2 Byes, etc. 
- l and 1 for 1 Leg Bye, l and 2 for 2 Leg Byes, I and 3 for 3 Leg Byes, etc.  
- b and 1 for 1 Bye, b and 2 for 2 Byes, b and 3 for 3 Byes, etc. 

- x to open the Wicket window, to be completed as required. 
- p to open the Penalty Runs window, to be completed as required. 
- o to End Over with less than six legal deliveries, or any over in Auto End Over mode OFF. 
- Delete or Escape to Undo Ball or Undo End Ball. 
- F2 to Enter and Exit Edit Mode. 
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Edit Mode 
Edit Mode allows you to make fix errors made during previous balls.  

1. To enter Edit Mode and edit a previous ball, click ‘Edit’ in the ‘Play Control’ panel then use the 'Ball by Ball' 
panel to select to the ball you would like to edit.  

2. Perform the required edit(s) on the ball(s) by using the ‘Scoring’ panel and/or the buttons in the ‘Play Control’ 
panel (e.g., changing batsman's Runs to Leg Byes).  

3. Click ‘Edit’ again to save the changes and exit Edit Mode.  

If a ball is edited in such a way as to have consequences for either the batting order (e.g., changing the Striker to a 
different batsman) or subsequent deliveries (e.g., changing a 1 to a 2), an 'Auto Correct' prompt will appear.  

 

Click ‘Yes’ or ‘Auto-Correct’ if you wish to continue with all suggested changes, and ‘No’ or ‘Continue without Auto-
Correct’ if you only wish to make your change to the highlighted ball.  

Pro Cricket Scorer has been built to maintain the correct sequence of Strike/Non-Striker/Bowler for every delivery, so 
some changes in Edit Mode will result in other prompts asking for additional information to maintain this sequence, so 
please provide the correct answer for prompts.  

 

 

 

 

 

 

Click ‘No – Switch Batsmen Anyway’ to ignore these warnings when you know that your change is the result of 
another error that can be edited later, or if the batsmen have gone to the wrong ends after a break and the umpires 
have allowed play to resume. 

Edit Match Details and Teams 

To edit the Teams or Match Officials after the match 
has been created, go to the ‘Scoring’ menu and 
select ‘Match Details/Teams’ to open the ‘Edit 
Match’ window.  

If you wish to edit a player’s Scoreboard Name, 
double-click on their ‘Short Name’ cell in the team 
list, enter the desired name and click ‘Save’. 

If you wish to edit a team's Scoreboard Name, click 
the ‘Edit’ button next to the Team name, then click 
‘Edit Team Names for this Match only’, enter the 
desired name and click ‘Save’. 

Changes to a player or team ‘Short Name’ will be 
highlighted in red, to indicate that these are applied 
to the current match only and are different to the 
server record of the player(s) and team(s). If you 
believe a change should be saved to the server, 
contact NZC.  
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If a Twelfth Man becomes a Concussion Substitute or Covid Substitute you must unselect them as the Twelfth Man. To 
do this click on their name or dropdown arrow next to it, select the blank option at the top of the player list, and click 
‘Save’. This will un-nominate them as Twelfth Man so that they appear on the batting and bowling lists and can be 
selected from their as an active player.  

To edit a previous innings, go to the ‘Scoring’ menu and select the required innings from the top of the list, and edit 
the required ball(s) as above. 

 

Innings and Milestone Notes 
The Default Scoring layout includes an ‘Innings Notes’ panel and ‘Milestone Notes’ panel stacked together.  

Innings Notes include all automated notes such as, 

- Batsmen's, Partnership, and Team 50s, 100s, etc. 
- Breaks in Play such as Drinks, Lunch, Rain, etc.  
- New Ball, Retirement, Shortened Match details, etc.  

Manual innings notes, such as revised hours of play, replacement balls, DRS referrals etc. can be added via Click to 
add, typing in the text box, and pressing the Enter key.  

Both automated and manual notes can be edited by double-clicking them to open the text box, adding additional info 
or amending existing text (e.g., changing the minutes on a milestone) and pressing the Enter key to save. 

 

 

 

 

 

 

 

Milestone Notes must be recorded by Live Scorers when milestones or records occur. Due to the nature of live cricket, 
scorers may need to delay entering milestone notes until there is a break in play. Click the ‘Milestone Notes’ tab, then 
‘Click to add’, type the text and press the Enter key to save.  

These include, Debuts, Appearance milestones, Batting, Bowling and Fielding milestones, Consecutive performances, 
Personal milestones, Personal records, Team or Format records, Partnership records and Match Official milestones.  

Refer to the NZC Guide to Milestone Notes to see the full list of milestones and records that should be noted and the 
correct format that should be followed. Use www.nzc.nz/archive to track these milestones and records.  

 

Power Plays 

The standard Power Plays for short-form matches are setup 
by default, so generally they will not require any changes. 
However, Power Play overs are adjusted in reduced over 
matches. PCS will automatically apply changes to the Power 
Plays in this instance, but Scorers should check to confirm 
they are correct. 

1. Go to the ‘Scoring’ menu, select ‘Power Plays’. 
Adjust each Power Play so they are correct as per 
your umpire or match referee’s instruction. 

 

  

http://www.nzc.nz/archive
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Delayed Play 
1. Record the reason for the delay by using the ‘Play State’ 

dropdown list. If you are Live Scorer, the Play State informs the 
scorecard on the nzc.nz website. 
 

2. Use ‘Rain’ when it is raining. Change to ‘Ground Delay’ when the 
groundsmen start preparing the outfield for play. All other Play 
States should be used at the appropriate times.  
 

3. To check and edit Play State history, go to ‘Scoring’ menu, and 
select ‘Breaks/No Play State…’ Click on the Start Time or End 
Time to make edits. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. When setting the Play State to ‘Lunch’, ‘Tea’, or ‘End of Day’ you will be prompted to set the Resumption 
Time. you can now click the highlighted ‘Set Resumption/No Play State’ button to set a resumption time. 
 

5. After setting the Play State to ‘Rain’, ‘Ground Delay’, ‘Bad Light’, or ‘Break in Play’ you can click the 
highlighted Resumption Time button next to the Start Play button. From the drop-down menu you can select 
‘Ground Inspection at…’, ‘Umpire Inspection at…’, or ‘Umpire Decision at…’. Select a Resumption Time by 
using the time selection arrows and/or the drop-down menu to ensure the correct time format, ‘XX:XX am’ 
including the space and lowercase am/pm. 
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DLS and Revised Overs / Target 

Short Form Match 

1. If overs are reduced prior to the start of play, go to the ‘Scoring’ menu, and select ‘Revised 
Overs/Target/DLS…’, click ‘Add’ to add a break in play to the ‘Revision History’ list for this match. Double click 
the ‘Revised Overs’ box and enter the amount overs that will be played per innings as decided by the Match 
Referee or Umpires. Click ‘OK’ to confirm the change, if you are Live Scorer, this will update the scorecard on 
the nzc.nz website. 

 

 

 

 

 

 

 

 

 

 

 

2. If there is an additional pre-match delay following the initial agreement of resumption time and a reduction 
of overs, create a new entry in the ‘Revision History’ list by clicking ‘Add’. Do not delete the original entry. 
This process must be completed before play starts. If it is not, double-click on the Over/Ball box and select 
the correct Over/Ball that the break started. 
 

3. If a short-form match is reduced in overs after play begins, go to the ‘Scoring’ menu, and select ‘Revised 
Overs/Target/DLS…’, ensure the ‘Auto-Update using DLS’ checkbox is ticked and that the latest version is 
selected from the dropdown list. Click ‘Add’ to add the break to the ‘Revision History’ list, which will 
automatically populate the current Innings, Over, Ball, Score, and number of overs per team in the Revised 
Overs box, which can be double-clicked to enter the new number of Revised Overs per team, then click ‘OK’. 
 

4. If a match is reduced in the second innings, return to the ‘Revised Overs/Target/DLS’ window, ‘Add’ a break, 
double-click on the Revised Overs box of the latest entry, and enter the reduced number of overs per team. 

 

 

 

 

 

 

 

 

 

 

 

Note: This action will automatically calculate the new Revised Target in the adjacent box. Whenever this occurs, you 
must print out new DLS Par Score sheets (See Page 17). 
 
This process must be completed every time there is a break that reduces the number of overs per team.  
 
If a break is entered here that did not result in a reduction of overs, highlight it, and click ‘delete’. 



17 

 

Short Form Match - DLS Par Score Sheets 

Once the first innings has been completed (whether 
shortened or not), you must create DLS Par Score 
Sheets. 

 
1. Go to the ‘Scoring’ menu, select ‘Revised 

Overs/Target/DLS…’, click the ‘DLS Par 
Table’ icon at the bottom-left to open the 
‘DLS Par Score Table’. 
 

2. Ensure ‘Auto-update using DLS’ is ticked, 
select either the Over by Over or Ball by Ball 
option, and click the drop-down arrow on 
the ‘Print’ button to choose either ‘Print…’if 
you are connected to a printer, ‘Save as 
PDF…’ if you would like to save the file and 
transfer it to someone else to print, ‘Email 
as PDF…’ if you are signed into your emails 
and can send the file to those who require 
it. Click ‘OK’ to exit. 

 

Long Form Match 

1. If overs remaining in the day are reduced during a long form match at any time, go to ‘Scoring > Overs 
Remaining/Target’. Edit the ‘Overs Remaining in Day’ number and click ‘OK’. 
 

2. Additionally, at the start of each Innings, you will be prompted to Confirm Overs Remaining for the day. 

 

 

 

 

 

 

 

End of Innings / Match 
When an innings come to a natural conclusion, i.e., All Out, End of Overs, or 
Target Reached, you will receive an End of Innings prompt. If you have no 
edits to do, click ‘Yes’.  If you have edits to do, click ‘No’.  

1. You can end the innings at any time by selecting ‘End of Innings’ or 
‘End of Match’ from the Play State dropdown list.  
 

2. Alternatively, go to the Scoring menu, and select ‘End Innings…’.  
 

3. If an innings has ended by another means, i.e., Declaration, Forfeit, or 
Play Called Off (due to external circumstances) use the ‘End of 
Innings’ or ‘End of Match’ options in the Scoring menu.  

If it is not the last innings of the match, the next innings will not be started until you click the ‘Next Innings’ button.  

If it is the last innings of a match, the ‘Edit Match Result/Points’ window will open, with the ‘Result Display’ 
automatically calculated, check this is correct and click ‘Save’.  

If a Twenty20 match ends in a Tie and has a Super Over, an End of Innings prompt will appear, click ‘Yes’, click ‘Next 
Innings’, select the batting first in the Super Over, and click ‘Save’. If you click ‘No’ to this prompt, you will need to end 
the innings manually as above. 
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Scorecards and Scoresheets 
To save or print a Scorecard at the end of a match, go to the ‘Statistics’ menu, and click ‘Match Scorecard’. Tick the 
‘Show Scorecard Notes’ and ‘Include Ball Numbers’ checkboxes if required, and either click ‘Print’ or the dropdown 
arrow to ‘Save’ or ‘Email’ a PDF version.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If save or print a traditional format Scorebook, go to the ‘Statistics’ menu, click Scorebook, and select ‘Full 
Scorebook…’ or an individual innings to open the ‘Match Scorebook’ window. Tick the ‘Include Ball Numbers’ 
checkbox if required, and either click ‘Print’ or the dropdown arrow to ‘Save’ or ‘Email’ a PDF version. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For other options regarding the format of the Scorebook, go to the ‘Tools’ menu, select Configuration, go to the 
‘Scoring’ tab, and tick or un-tick the various checkboxes as required, and click ‘OK’.  


